
Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

VT-HACD-DPQ

Digital Controller for electro-hydraulic  

Injection Molding Machines

Start-up and Operation

RE 30146-01-B/08.07
Replaces: 11.06



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

2/108 Bosch Rexroth AG  |  Hydraulics VT-HACD-DPQ  |  RE 30146-01-B/11.06 

 

Contents 

1 Introduction................................................................................................6 

1.1 General ........................................................................................................6 

1.2 Signs and symbols used in this document...................................................6 

2 Overview of injection control for injection molding machines .............8 

2.1 General ........................................................................................................8 

2.2 The system components..............................................................................9 

2.3 Electrical and hydraulic installation plan ....................................................10 

2.4 Sequence diagram and functional description...........................................11 
Intern or bus mode ..................................................................................................... 11 
Analog mode .............................................................................................................. 12 

2.5 Safety notes...............................................................................................13 

3 User interface BODAC - General ............................................................14 

3.1 Software Tool and Data Handling..............................................................14 
The BODAC Software ................................................................................................ 14 
Data exchange between BODAC and the HACD-DPQ .............................................. 14 
Save file ..................................................................................................................... 15 
Save the working state ............................................................................................... 15 

3.2 Main Menu .................................................................................................16 
Title bar ...................................................................................................................... 16 
Menu bar .................................................................................................................... 17 
BODAC toolbar........................................................................................................... 17 
Window toolbar........................................................................................................... 19 
The HACD-DPQ main menu ...................................................................................... 21 

DPQ main menu for intern or bus mode ............................................................. 21 
DPQ main menu for analog mode ...................................................................... 22 
Configure field .................................................................................................... 22 
Profiles field for intern or bus mode.................................................................... 23 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30146-01-B/11.06  |  VT-HACD-DPQ Hydraulics  |  Bosch Rexroth AG  3/108 

 

Profiles field for analog mode ............................................................................. 23 
Diagnostics......................................................................................................... 23 

Status bar ................................................................................................................... 23 
Short cut keys list ....................................................................................................... 24 

4 BODAC – Menu Description ...................................................................25 

4.1 File menu ...................................................................................................25 
Open .......................................................................................................................... 25 
Save ........................................................................................................................... 25 
Printer Setup .............................................................................................................. 26 
Print............................................................................................................................ 26 
Exit ............................................................................................................................. 26 

4.2 Controller menu .........................................................................................27 
Offline......................................................................................................................... 27 
Connect ...................................................................................................................... 27 
Read parameters........................................................................................................ 27 
Write parameters........................................................................................................ 28 
Set Parameters to Memory......................................................................................... 28 
Language ................................................................................................................... 28 
Card information......................................................................................................... 29 

4.3 View menu .................................................................................................30 

4.4 Configuration menu ...................................................................................31 
Analog I/O .................................................................................................................. 31 

Inputs field .......................................................................................................... 32 
Output field ......................................................................................................... 33 

SSI ............................................................................................................................. 34 
Incremental................................................................................................................. 36 
BUS Manager (Profibus, CANopen, DeviceNet) ........................................................ 38 

4.5 Tools menu ................................................................................................42 
Preferences ................................................................................................................ 42 
Utilities........................................................................................................................ 46 

4.6 Application Screens menu .........................................................................47 
The HACD-DPQ main menu ...................................................................................... 48 
IN/ OUT Config........................................................................................................... 48 
Injection...................................................................................................................... 48 
Pack and hold............................................................................................................. 48 
Back pressure ............................................................................................................ 49 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

4/108 Bosch Rexroth AG  |  Hydraulics VT-HACD-DPQ  |  RE 30146-01-B/11.06 

 

Loop Tuning ............................................................................................................... 49 
Spool config................................................................................................................ 49 
2 valve / Bus option .................................................................................................... 49 
Motion Data ................................................................................................................ 50 
Jog Mode ................................................................................................................... 50 
Bus Trigger................................................................................................................. 50 
Controller Structure .................................................................................................... 50 
Test jacks ................................................................................................................... 51 
Motion Data ................................................................................................................ 53 
Multiplot ...................................................................................................................... 58 

Multiplot toolbar .................................................................................................. 59 
Multiplot Display ................................................................................................. 62 
Multiplot Display Legend .................................................................................... 62 
Winview recording .............................................................................................. 64 

Status ......................................................................................................................... 66 
Bus Trigger................................................................................................................. 68 
Controller Structure .................................................................................................... 69 

4.7 Window menu ............................................................................................70 

4.8 Help menu .................................................................................................71 
About BODAC…......................................................................................................... 71 
Topics......................................................................................................................... 71 
Example ..................................................................................................................... 71 

5 Application: Controller for injection molding machines......................72 

5.1 Startup reference list..................................................................................72 

5.2 Establish communication ...........................................................................73 
Data exchange between the BODAC software and the HACD-DPQ closed-loop 
controller electronics .................................................................................................. 73 
Open or create parameter file..................................................................................... 73 

5.3 Select mode...............................................................................................74 

5.4 Adjust configuration ...................................................................................75 
Configure inputs and outputs...................................................................................... 75 

General Config. .................................................................................................. 76 
Discrete Outputs................................................................................................. 77 
Pressure Control ................................................................................................ 77 
Buttons ............................................................................................................... 77 

Configure spool flow curve ......................................................................................... 77 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30146-01-B/11.06  |  VT-HACD-DPQ Hydraulics  |  Bosch Rexroth AG  5/108 

 

Adjust controller parameter for velocity and pressure for internal mode..................... 81 
Adjust controller parameter for velocity and pressure for analog mode...................... 84 
2 Valve / Bus option ................................................................................................... 86 
Configure velocity for jog mode.................................................................................. 90 
Controller structure..................................................................................................... 91 

5.5 Define profiles for internal or bus mode.....................................................93 
Configure profiles for injection .................................................................................... 93 
Configure profiles for pack and hold........................................................................... 95 
Configure profiles for back pressure including pre- and post-decompression ............ 99 

Pre-Decompression.......................................................................................... 100 
Back Pressure .................................................................................................. 101 
Post-Decompression ........................................................................................ 102 

Creating command values with ramps ..................................................................... 104 

5.6 Save parameter file..................................................................................105 

5.7 Process settings ......................................................................................106 
Motion data............................................................................................................... 106 
Test jacks ................................................................................................................. 106 
Status overview........................................................................................................ 106 

5.8 Start application .......................................................................................107 

Glossary.............................................................................................................90 

Index...................................................................................................................92 
 

 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

6/108 Bosch Rexroth AG  |  Hydraulics VT-HACD-DPQ  |  RE 30146-01-B/11.06 

1 Introduction 

 

1 Introduction 

1.1 General 

In this manual you will become familiar with:  

 The VT-HACD-DPQ-1 digital controller for injection molding machines 

 The BODAC (Bosch Rexroth Operator interface for Digital Axis Controller) soft-
ware  

 Application examples 
 
You will learn about the menus and window contents for the software, the settings and 
parameters. 

Selected application examples will clarify the functionality, systematics and recom-
mended procedure for starting up the "VT-HACD-DPQ - Digital controller for injection 
molding machines". 

The software description assumes basic familiarity with a PC and appropriate knowl-
edge of the user interface and operating elements of WindowsTM. 

For additional information, read the relevant chapters in the Microsoft Windows user’s 
manual or use Windows online help. 

Information about installing and operating of the HACD-DPQ controller can be found 
in the manual "Installation and Operation of the HACD-DPQ Digital controller for injec-
tion molding machines". 

A listing of HACD-DPQ documentation can be found in the datasheet RE 30146. 

Version status of this document: 1.3 

 

 

1.2 Signs and symbols used in this document 

The following signs and symbols  are used in this manual: 

 Activity symbol: The text following this sign describes activities. These are to be 
performed from top to bottom in the order indicated. 

 Result symbol: The text following this sign describes the result of an action. 
 

 

After this symbol you will find notes and useful tips for optimal use of 
the controller card. 
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Introduction 1 

 

 

After this symbol you will find references to additional documentation. 

 

Special safety notes are provided at the relevant locations. These are indicated using 
the following symbols. 

 

General hazard This sign is placed in front of activities which repre-
sent a potential hazard to persons and/or extensive damage to equip-
ment. 

 

If the source of the hazard can be exactly defined, the corresponding pictogram is 
used. 

 

Shock hazard This sign is placed in front of activities which represent 
a potential hazard to persons and/or extensive damage to equipment 
due to high electrical voltage. 

 

 

Equipment hazard  
This sign is placed before activities which may result in damage to 
equipment. 

 

 

Warning signs 
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2 Overview of injection control for injection molding machines 

 

2 Overview of injection control for injection molding 
machines 

2.1 General 

The function of the injection unit on an injection molding machine is to take a granular 
plastic material, melt and mix it (plasticize). Then inject it under pressure into a cavity 
and keep the melted material under pressure while it cools to form a solid part. 

Parameter changes may be individually loaded into the card, or the entire 
profile loaded at one time. The card maintains the last saved profile in non-
volatile flash memory. A single injection motion profile is stored on the card. 
Multiple profiles may be stored in the machine sequential logic controller and 
any one selected to load into the card. 

The process of injection molding can be described as follows: 

In the injection phase the plasticized mass is injected into the mold. Depending on the 
material used or the nature of the mold, the injection cylinder must be controlled with a 
varying speed profile. This minimizes the effects such as fluid temperature, mold filling 
pressure or cylinder friction. 

In this phase the material is already in the mold and must be kept under pressure for a 
short time. Minimizing the effect of factors affecting the pressure curve in the mass is 
important for good repeatability of the injection molding process. 

To allow a nozzle shut-off valve to close after hold pressure is complete, residual 
material pressure can be decompressed by retracting the screw a short distance. 

Backpressure (also known as plasticizing or recovery) is used to fill the injection unit 
with melted plastic. Rotating of the screw causes material to be pulled into the heated 
barrel where it melts while being augured towards the front of the screw. Material 
pressure at the screw tip forces the injection cylinder backwards and creates a hy-
draulic pressure - the back pressure. When the required plastic volume is accumu-
lated rotation of the screw is stopped. 

To prevent melted plastic from entering the mold area while the cooled part is re-
moved, residual material pressure can be decompressed by retracting the screw a 
short distance before the mold is opened. 

 

The injection process 

The process sequence 

Injection 

Pack and hold 

Pre-Decompression 

Back pressure 

Post-Decompression 
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2.2 The system components 

 
Fig. 1 System components 

 

1 Tank with check valve 

2 4/3-directional control valve with integrated electronics and Q spool 

3 Pressure transducers for voltage/current pressure inputs 

4 Position transducer for position actual value 

5 Injection cylinder with feed hopper, plasticizing screw and hydromotor. 

6 HACD-DPQ Digital Closed-Loop Control Electronics 
 

Required  
system components 
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2 Overview of injection control for injection molding machines 

 

2.3 Electrical and hydraulic installation plan 

 
Fig. 2 Electrical and hydraulic installation plan 

 

Operation and process control 

 

Controller for injection molding machines 

 

4/3-directional control valve with Q-type spool, hydraulic elements (injection cylinder) 
and feedback (position actual value) 

 

PLC 

HACD-DPQ 

Injection molding machine 
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Overview of injection control for injection molding machines 2 

 

2.4 Sequence diagram and functional description 

Intern or bus mode 

 
Fig. 3 Sequence diagram for intern or bus mode 

 

 

* no settings necessary/possible. 

 
The machine control provides the signals to start injection. A rising edge on digital 
input DI 2 & DI 4 starts the injection phase. During this phase the velocity of the injec-
tion cylinder is regulated according to a stored profile. In addition, the pressure on the 
piston side of the cylinder can be limited to a maximum value. 

Transfer from injection phase into Pack and Hold phase is triggered when the ma-
chine control sends a rising edge to input DI 3 or internal setpoint for position or pres-
sure is reached. At transfer the velocity control is turned off and the hold-pressure 
profile is started. During this phase the pressure is regulated according to a stored 
profile. 

If a value is set in the screen the “screw retract” (pre-decompression) phase will start 
automatically after pack and hold. 

Output DO 5 turns on when Decompression position is reached. 

A rising edge on input DI 1 starts the back pressure phase. DO3 acknowledges that 
the HACD-DPQ is in the Back pressure phase. The machine control drives the screw-
motor. Rotating of the screw causes material to be pulled into the heated barrel where 
it melts while being augured towards the front of the screw. Material pressure at the 
screw tip forces the injection cylinder backwards. A rising edge on output DO 6 (At 

Injection phase 

Pack and hold phase 

Pre-Decompression phase 

Back pressure 
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2 Overview of injection control for injection molding machines 

 

shot size) indicates that sufficient material is available for injecting. Also DO3 is 
switched when Shot Size Position is reached. The machine control then stops rotation 
of the screw. The back pressure phase is ended. 

A rising edge on input DI 6 starts the retraction of the screw to a defined position.  

Output DO 5 turns on when Decompression position is reached. 

 

 

Analog mode 

 
Fig. 4 Sequence diagram for analog mode 

 

 

* no settings necessary/possible. 

 
In analog mode all commands (velocity and pressure) are generated by the PLC and 
sent to the analog inputs of the HACD-DPQ card. 

 
The machine control provides a rising edge to digital input DI 7 to start the injection 
phase.  

The machine control sends a rising edge to input DI 3 to transfer from closed loop 
velocity into open loop velocity. Pressure control remains active.  

Post-Decompression 

Injection phase 

Pack and hold phase 
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If Pre-Decompression is required the machine control sends a rising edge to DI 8. The 
HACD-DPQ changes to open loop velocity mode and pressure control is turned off. 

The machine control sends a rising edge to input DI 3 to start the back pressure 
phase. The machine control drives the screw-motor. Rotating of the screw causes 
material to be pulled into the heated barrel where it melts while being augured to-
wards the front of the screw. Material pressure at the screw tip forces the injection 
cylinder backwards. The machine control stops rotation of the screw when it deter-
mines that shot size is reached. The back pressure phase is ended. 

If Post-Decompression is required the machine control sends a rising edge to DI 8. 
The HACD-DPQ changes to open loop velocity mode and pressure control is turned 
off.  

 

 

2.5 Safety notes 

 

CAUTION! 
Non-observance of these safety precautions can result in damage 
to the equipment. 

 

 

Only configure and start the application if: 

 You have defined the zero point at the stop point of the screw cylin-
der ("0" position);  

 You have checked all the entered parameters to verify they are cor-
rect. Parameterizing is done using absolute values. The values in the 
steps for the individual profiles are dependent on each other. 

 
 

 

 

 

 

 

 

Pre-Decompression phase 

Back pressure 

Post-Decompression 
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3 User interface BODAC - General 

3.1 Software Tool and Data Handling 

The BODAC Software 

BODAC is a software tool for startup. It must be installed on the PC or laptop that is 
used for the initial startup. 

BODAC stands for: 
Bosch Rexroth Operator interface for Digital Axis Controller for in- and output match-
ing, controller structuring, parameterizing, process display and diagnostics. 

This software tool can be downloaded from the Internet at 
http://www.boschrexroth.com/hacd. 

 

Data exchange between BODAC and the HACD-DPQ 

Establish a connection between the PC and the HACD-DPQ so that the desired data 
can be set, saved and duplicated. 

The connection is based on RS232. A fixed baud rate of 57600 baud is set in the 
card. 

 Connect PC to HACD-DPQ using an RS232 cable (1:1 cable)  
 
Connection cable: 
Type: KABELSATZ VT-HACD-1X/03,0/HACD-PC 
Part number: R900776897 
Length: 3 m 

 Turn on PC and HACD-DPQ 

 Install BODAC 

 Start BODAC 

 BODAC automatically loads the parameter set from the HACD-DPQ 

 

 

If BODAC does not load automatically, no connection was made. In 
this case check the "Configuration of the serial interface", the serial 
connection and the supply voltage to the HACD-DPQ. 

 

 

If your PC doesn't have a RS 232 port you can use an USB to serial 
converter.  
USB to serial converter: 
Type: VT-ZKO-USB/S-1-1X/V0/0 
Part number: R901066684 
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User interface BODAC - General 3 

 

 

Save file 

It is recommended that the parameter set be saved in a file. This allows you to restore 
the current status of the HACD-DPQ at any time.  

Assign a file name and save the output state. 

 

Save the working state 

This allows you to easily store all parameters and structure specifications during 
startup. If work is interrupted, it can be resumed at a later stage without any loss of 
data. 

 

 

When finished, also save the files in the permanent memory of the 
HACD-DPQ card. 
See also: "Save". 
See also: "Set parameters to memory". 
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3 User interface BODAC - General 

 

3.2 Main Menu 

After opening the BODAC program, the BODAC main menu is shown. This contains 
various elements as shown in Fig. 5 BODAC Main Menu.  

These include: 

 The title bar 

 The menu bar 

 The toolbar 

 The HACD-DPQ-DPQ main menu 

 The status bar 

 

 

 
Fig. 5 BODAC main menu 

 

Title bar 

The title bar contains the name of the program or window and several standard Win-
dows buttons. Information about the standard Windows buttons can be found in the 
Windows online help. 
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User interface BODAC - General 3 

 

Menu bar 

The menu bar contains all the menus and commands available in BODAC. 

The following menus are available: 

 File menu 

 Controller menu 

 View menu 

 Configure menu 

 Tools menu 

 Application Screens menu 

 Window menu 

 Help menu 

 

BODAC toolbar 

The toolbar contains buttons with icons. These icons execute the most commonly 
used functions and commands or open windows. 

Following is a list of the functions executed by the icons: 

 

Generates the "Offline" command, which breaks the connection to the 
card. The symbol is only visible if there is no currently active connec-
tion to the card. 

 

Generates the "Connect" command. The symbol is only visible if there 
is no currently active connection to the card. 

 

Opens the "Open" window, where you can select stored BODAC data 
files. 

 

Opens the "Save file as" window, in which you can save your entries. 

 

Opens the "Analog in-/outputs" window. 

 

The "Read parameters" command reads the data (parameter set) 
stored in the working memory of the HACD-DPQ and passes them to 
the BODAC program. 
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3 User interface BODAC - General 

 

 

The "Write parameters" command sends the current data (parameter 
set) from the BODAC to the working memory of the HACD-DPQ. 

 

The "Save parameters in memory" sends the HACD-DPQ parameter 
set from working memory to permanent memory. 

 

Opens the "Language" window. 

 

Opens the "Print forms" window. 

 

Opens the "HACD-DPQ-DPQ main menu" window if mode is intern or 
bus. 

 

Opens the "Config.Input.Velocity" window if mode is analog. 

 

Opens the "Injection" window. 

 

Opens the "Pack and Hold" window. 

 

Opens the "Back Pressure" window. 

 

Opens the "Motion Data" window. 

 

Opens the "Test jacks" window. 

 

Opens the "Status" window. 
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User interface BODAC - General 3 

 

 

Opens the "Loop tuning" window for intern or bus mode. 

 

Opens the "Loop tuning" window for analog mode. 

 

Opens the "In/Out Configuration" window. 

 

Opens the "2 valve/ Bus option" window. 

 

Opens the "Spool configuration" window. 

 

Opens the "Jog mode" window. 

 

Window toolbar 

The window toolbar contains buttons with symbols (icons) which the user can click on 
to execute the most commonly used functions and to invoke commands or open win-
dows. 

Following is a list of the included functions: 

 

see Chapter 4.2 "Read Parameters". 

 

see Chapter 4.2 "Write Parameters". 

 

Clicking on this icon writes only the current changed parameter value 
to the controller card. 
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The "Set parameters to memory" sends the current data from BODAC 
to the memory chip of the controller card. 

 

If you are in an entry field, clicking on the symbol increments the field 
contents. BODAC simultaneously writes this parameter to the card. 

Exception: Multiplot, see "Multiplot toolbar" 

 

If you are in an entry field, clicking on the symbol decrements the field 
contents. BODAC simultaneously writes this parameter to the card. 

Exception: Multiplot, see "Multiplot toolbar" 

 

The Undo symbol in the toolbar nullifies the last entry. 

 

Clicking on the oscilloscope symbol in the toolbar opens the BODAC 
"Multiplot" window.  
To show signals in the multiplot window, open the Motion Data window 
and click on the name of the desired signal. The name of the signal is 
highlighted in red to indicate that it is selected for display in the mul-
tiplot window. Then click on the oscilloscope symbol in the toolbar to 
open the multiplot window. The signals you selected will be displayed. 

Within the "Multiplot" window. 

A maximum of 8 signals can be selected. 

For information on the multiplot window, see section 4.3 "Multiplot". 

 

Clicking on the printer symbol in the toolbar opens the Windows "Print" 
system window. 

 

The Help symbol in the toolbar generates a help pointer. Clicking with 
the help pointer on a parameter field opens the help for this parameter 
field. 
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The HACD-DPQ main menu 

The HACD-DPQ main menu is automatically opened whenever the program is started 
depending on mode. 

It contains all the required menus for the "Injection control for injection molding ma-
chines" application described in section 4. 

DPQ main menu for intern or bus mode 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "HACD-DPQ-DPQ main menu" window. A listing of 
existing shortcuts for the toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 6 The HACD-DPQ-DPQ main menu for intern or bus mode 
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DPQ main menu for analog mode 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "HACD-DPQ-DPQ main menu" window. A listing of 
existing shortcuts for the toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 7 The HACD-DPQ-DPQ main menu for analog mode 

 

Configure field 

This fields are accessable in security level 2 only. 

Opens the "In/Out Cfg" window. 
You select the signals for the inputs and outputs for your application. 

See also: Section 5.4 "Adjust configuration". 

Opens the "Spool config" window. 
You can adjust the HACD-DPQ-DPQ to the flow characteristic of the injection valve 

See also: Section 5.4 "Adjust configuration". 

Opens the "Loop tuning" window. Depending on the mode the "Loop tuning" or the 
"Loop tuning analog" window opens. 
You can made all the necessary control loop settings with the control parameters 

See also: Section 5.4 "Adjust configuration". 

Opens the "Jog mode" window. 
With the jog mode you can move the injector in open loop control.  

See also: Section 5.4 "Adjust configuration". 

 

In/ Out Config  

Spool 

Loop Tuning 

Jog Mode 
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Profiles field for intern or bus mode 

Opens the "Injection" window. 
You can parameterize the injection phase. 

See also: Section 5.5 "Configure profiles". 

Opens the "Pack and Hold" window. 
You can parameterize the pack and hold phase. 

See also: Section 5.5 "Configure profiles". 

Opens the "Back Pressure" window. 
You can parameterize the back pressure phase. 

See also: Section 5.5 "Configure profiles". 

 

Profiles field for analog mode 

Opens the "Analog mode" window. 
You see the information how to start the analog mode. 

 

Diagnostics 

Opens the "Test jacks" window. 
You can assign signals for diagnostic purposes to the diagnostic terminal "X1" and 
"X2". 

See also: Section 5.7 "Test jacks". 

Opens the "Motion data" window. 
You can see all signals of your application in real-time. 

See also: Section 5.7 "Motion data" 

 

Status bar 

The status bar contains useful information about the active window. For example the 
main menu shows the current connection status. 

 
Fig. 8 BODAC Status bar 

 

Injection 

Pack and hold 

Back pressure 

Analog mode 

Test jack 

Motion Data 
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Short cut keys list 

The function keys below are short cuts to important operations in the BODAC pro-
gram. 

F1 Opens BODAC Help. (see also "Help menu") 

F2 Reads the parameter data stored in the control card and transfers it to 
the BODAC program. (see also "Read parameters")  

F3 Sends the current parameter data from BODAC to the control card. This 
action overwrites the previously stored data in the volatile memory. (see 
also "Write parameters") 

F7 Stores the current parameter data in the memory chip on the control 
card. (see also "Saving parameters in memory")  

F8 Pressing "F8" sends only the last changed parameter value to the control 
card. 

F11 In an entry field, pressing "F11" increments the value. BODAC simulta-
neously writes this parameter to the control card.  

F12 In an entry field, pressing "F12" decrements the value. BODAC simulta-
neously writes this parameter to the control card. 

Page down Within the structure or parameter editor in the Block entry field, "Page 
down" is used to increment the entry field contents. This opens up the 
next higher block. 

Page up If you are within the structure or parameter editor in the Block entry field, 
"Page up" is used to decrement the entry field contents. This opens up 
the next lower block. 
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4 BODAC – Menu Description 

4.1 File menu 

The "File" menu contains commands for administering and printing data. 

 
Fig. 9 File menu 

 

Open 

Opens a window in which you can load a complete parameter structure, which was 
previously created and saved in BODAC. The profile contains all the values and pa-
rameters that were specified and entered before saving in BODAC. 

 

Clicking on the preceding icon, which is part of the toolbar, also opens 
the window in which saved data files can be selected. A list of existing 
short cuts for the toolbar can be found in the "Toolbar" section. 

 

Save 

Opens a window in which all the data can be saved that was entered in BODAC.  The 
saved file can then be used in other cards to duplicate the functionality. 

 

Clicking on the preceding icon, which is part of the toolbar, also opens 
the window in which you can save the data entered in BODAC. A list of 
icons for the toolbar can be found in the "Toolbar" section. 

 

 

 

Save the complete parameter structure after the installation is com-
plete! When replacing a defective card the existing parame-
ters/structure can be transferred to the new controller card. This card is 
then ready to be used with all the previously defined parameters and 
settings. The existing parameter files can also be sent to identical or 
similar applications. 
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Printer Setup 

This menu point opens the standard Windows "Printer Setup" window. Information 
about setting up a printer can be found in your Windows online help. 

 

Print 

This menu item opens the "Print" window as shown in the illustration below. 

 
Fig. 10 "Print" window 

The window is divided into several columns. In the Print column, select the BODAC 
window to be printed. If the selected BODAC window consists of more than one sheet, 
use Options to select the number of data sheets to be printed. 

 

Clicking on the preceding icon, which is part of the toolbar, also opens 
the "Print forms" window. A listing of icons for the toolbar can be found 
in Section "Toolbar". 

 

Clicking on the Print button opens the standard Windows "Print" screen. Information 
about the Print system window can be found in Windows online help. 

 

Exit 

Closes all currently active windows and exits the BODAC program. 
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4.2 Controller menu 

The "Controller" menu contains commands for direct communication with the card. 
These commands are used to send or receive data to and from the controller card. 

 
Fig. 11 "Controller" menu 

 

Offline 

Closes the connection to the controller card. The "Offline" command is only selectable 
if there is no active connection to the controller card. 

 

Clicking on the preceding icon, which is part of the toolbar, also gener-
ates the "Offline" command. The icon is only visible if there is an active 
connection to the controller card. A listing of icons for the toolbar can 
be found in Section "Toolbar". 

 

Connect 

Opens the connection between BODAC and the HACD. The "Connect" command is 
only selectable if there is no currently active connection to the card. 

 

Clicking on the preceding icon, which is part of the toolbar, also gener-
ates the "Connect" command. The icon is only visible if there is an 
active connection to the controller card. A listing of icons for the toolbar 
can be found in Section "Toolbar". 

 

Read parameters 

The "Read Parameters" command reads the data currently stored in the controller 
card (Parameter set) and sends it to the BODAC program. 

 

Clicking on the preceding icon, which is part of the toolbar, also reads 
the settings and entries stored in the controller card and sends it to 
BODAC. A listing of icons for the toolbar can be found in Section "Tool-
bar". 

 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

28/108 Bosch Rexroth AG  |  Hydraulics VT-HACD-DPQ  |  RE 30146-01-B/11.06 

4 BODAC – Menu Description 

 

Write parameters 

The "Write Parameters" command sends the settings and entries, made in BODAC, to 
the controller card and overwrites the previously saved data in the volatile memory. 

 

NOTE!  

 
The new data is available as long as supply voltage is present on the 
controller card.  

Interrupting supply voltage to the controller card will result in loss of data.

 

To permanently store data on the controller card, see section "Set parameters to 
memory". 

 

Clicking on the preceding icon, which is part of the toolbar, also sends 
the settings and entries you made to the controller card and overwrites 
the previously saved data in the volatile memory. A listing of icons for 
the toolbar can be found in Section "Toolbar". 

 

Set Parameters to Memory 

Sends the current data in BODAC to the permanent memory on the controller card. 
This permanently saves the data in the controller card and makes it available even 
after power is cycled. 

 

The preceding icon, which is part of the toolbar, also sends the current 
data from BODAC to the controller card memory. A listing of icons for 
the toolbar can be found in Section "Toolbar". 

 

Language 

The "Language" menu contains the following options: 

 English 

 Deutsch 
 

 

The preceding icon, which is part of the toolbar, opens a selection 
menu in which you can also select the language. A listing of icons for 
the toolbar can be found in Section "Toolbar". 

Displays the entire text of the entries, windows, menus, etc. in English. 

Displays the entire text of the entries, windows, menus, etc. in German. 

English 

Deutsch 
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NOTE!  

 
The software language selection also affects the language version of 
your card. 

The menu tree which the buttons on the front panel of your card takes 
you to is also switched over to the selected language. 

The language selection is stored in the card. 

 

Card information 

Opens the "Card Information" window in which all the relevant data concerning hard-
ware and firmware for the controller card are shown. 

 
Fig. 12 "Card information" window 

The File menu in the "Card information" window corresponds to the BODAC main 
window "File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic, or to the contents page of the BO-
DAC windows help. 

In the upper section of the "Card information" window you will find the manufacturer 
data that exactly describes your controller card. 

Card information –  
File menu 

Card information –  
Controller menu 

Card information –  
Help menu 
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When contacting product support, have the following information ready: 

 Product (contains the unique product number of your controller card). 

 S/N 1 (contains the serial number of the controller card.) 

 Mat.-Nr. (contains the material number of your controller card.) 
 
Here the hard- and software used is listed in detail. 
 

In the entry field you can enter relevant comments that refer to your application and 
settings or important details. 

You can refer to this information later should you require startup details 

The field contains a standard text entered by Bosch Rexroth. The text entered here is 
shown in run mode as a running text on the controller card display.  This text can be 
edited to the user’s requirements.  In addition, a signal from the controller can be 
displayed. 

 

Additional information: "Installation and Operation of the Controller 
Card", RE 30146-B. 

 

 

 

4.3 View menu 

The View menu is not available for the HACD-DPQ. All relevant information is con-
tained in the application windows. 

 

 

Versions 

Comments 

Display Text 
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4.4 Configuration menu 

The Configuration menu contains commands used to define/configure the separate 
modules that make up the application. 

 
Fig. 13 Configuration menu 

 

Analog I/O 

The "Analog I/O" window is where all analog inputs on the controller card have to be 
configured. 

 

Clicking on the preceding icon, which is part of the toolbar, also opens 
the "Analog I/O" window. A list of existing icons for the toolbar can be 
found in Section "Toolbar". 

 

 
Fig. 14 "Analog I/O" window 
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The File menu in the "Analog I/O" window corresponds to the BODAC main window 
"File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic, or to the contents page of the BO-
DAC windows help. 

 

Inputs field 

The first column in the Inputs field lists the names of the analog inputs AI1 to AI6. 

In the following columns in the Inputs field you specify the parameter values for the 
analog input signals. 

 

Not all analog inputs can be configured as current inputs. 

 

Assignments are made with the mouse button. Clicking on the "Type" entry field 
opens a pull down menu containing the following: 

 +/-10V  
The expected input signal varies in a range of (–10V) to (+10V). 

 0~10V  
An input signal of from (0V) to (+10V) is expected. 

 0~20mA 
The current level of the input signal varies between (0mA) and (20mA). 

 4~20mA 
The current level of the input signal varies between (4mA) and (20mA). 

 
The "Min" value sets the minimum for the input signal. Depending on the setting of 
"Type" and "Range" this value is translated to the minimum value of the "Range" set-
ting. For example, a value of (-5V) means the signal (-5 V) is interpreted as (-100%) 
range (see Fig. 15 Analog I/O - Input adjustments). 

The "Max" setting is the opposite of "Min". For example, a value of (+9 V) means the 
signal (+9 V) is interpreted as (+100%) range (see Fig. 15 Analog I/O - Input adjust-
ments). 

Specifies the minimum error. When the signal falls below this entered value, BODAC 
uses the "Status" window to indicate that an error has occurred. 

Specifies the maximum error. When the signal exceeds this entered value, BODAC 
uses the "Status" window to indicate that an error has occurred. 

The "Max Units" setting specifies the conversion from Range [%] to Units [Unit]. 

Analog I/O - 
File menu 

Analog I/O - 
Controller menu 

Analog I/O - 
Help menu 

Type 

Min 

Max 

Min Error 

Max Error 

Max Units 
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The table and graphic below show the parameters for a signal adjustment in the In-
puts field. 

 
Max Unit
[Units]

-Min [V]

100

Max Unit
[Units]

-100

-5 9
Max [V]

100

-100

-10 10

Max [V]

Min [V]

-5

-100 100

9

analoge_ea_diag  
Fig. 15 Analog I/O – Input adjustments 

 

Output field 

Assignments are made with the mouse button. Clicking on the "Type" entry field 
opens a selection field containing the following: 

 +/-10V  
The expected output signal varies in a range of (–10V) to (+10V). 

 0~10 V  
An output signal of from (0 V) to (+10 V) is expected. 

 4~20 mA 
The current level of the output signal varies between (4 mA) and (20 mA). 

 
The parameter in the "Offset" entry field is used to offset the manipulated variable by 
the entered value. 

 Use the right mouse button to assign an entry from the selection fields to the 
parameters. 

 The output signal structure of the velocity and pressure controller are defined. 

 For configuring the Q-spool, see also section "Configure Q-spool flow curve". 

 This concludes the output configuration. 

 

Type 

Offset 

Adjust output elements 
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SSI 

The SSI window contains the definitions for using an appropriate encoder for measur-
ing the actual position. With the specification for a Synchronous Serial Interface in 
mind position data can be read and processed. 

  
Fig. 16 "SSI" window 

 

The File menu in the "SSI" window corresponds to the BODAC main window "File 
menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

Programmable or non-programmable encoders can be used. 

 

Enter the prescribed number of bits depending on the data protocol and the encoder 
type used. 
Number of possible bits: 1 to 24. 

Here BODAC makes it possible to accomodate various encoders. The value entered 
is dependent on requirements of the encoder. 

Condition Description 

BINARY Encoder with binary code 

GRAY Encoder with gray code 
 

 

SSI –  
File menu 

SSI –  
Controller menu 

SSI –  
Help menu 

NB. of Bits 

Data 
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Enter the mode of adjusting the transducer offset (zero point). 

Condition Description 

OFF Offset of transducer is adjusted by changing of the pa-
rameter "Offset". 

Digital Input 5 Transducer offset is set by digital input 5. The parameter 
"Offset" will be set automatically by this action. 
As long as the digital input is active the transducer offset 
will be re-set. 

Bus Transducer offset is set by a bus event. The parameter 
"Offset" will be set automatically by this action. 

 

This parameter is used to set the scale of the position feedback device. It has a range 
from 0 to 32767 Count/Unit. 

This parameter is used to offset the position feedback from the SSI probe. For exam-
ple if the zero point needed to be changed this parameter would be used to null out 
the offset. It has a range from 0.00 to 5000.00 units.  

 

Home Mode 

Resolution 

Offset 
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Incremental 

The Incremental window contains the definitions for using an appropriate encoder for 
measuring the actual position.  

 

NOTE!  

 
Attention! 

The conditioning electronics for the Incremental Encoder has a 
maximum detection frequency of 100 kHz. If this frequency is ex-
ceeded the actual position will not be decoded properly. 
When using this type of encoder the user needs to choose the 
maximum velocity such that, keeping the resolution of the encoder 
in mind, the maximum frequency of 100 kHz is not exceeded. 

 

 
Fig. 17 "Incremental" window 

The File menu in the "Incremental" window corresponds to the BODAC main window 
"File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

Incremental type position feedback transducers may be used with the controller. Sin-
gle ended 5Volt, Single ended 24Volt or 5 Volt differential line driver type may be 
used. Both single ended and quadrature types are supported. The feedback may be 
zeroed by using discrete input #5 or a zero bit over fieldbus. This is called the home 
mode. The home mode may be used along with a zero pulse from the encoder. These 
signals are "anded". 

 

This selects the type of encoder being used. The Encoder Channel A and Channel B 
faults are only active when Diff is selected. 

Incremental –  
File menu 

Incremental –  
Controller menu 

Incremental –  
Help menu 

Input Range 
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Condition Description 

SE 5V Encoder type with single ended outputs with 5V signal level.

DIFF Encoder type with differential output signals. 

SE 24V Encoder type with single ended outputs with 24V signal 
level. 

 
This selects whether the encoder is a quadrature or a single ended signal. 

Condition Description 

QUAD Quadrature ended encoder signal 

SINGLE Single ended encoder signal 
 
This parameter is used to give a home reference. The actual position could be read 
via the motion data screen and the value could be put in the offset. This would give a 
known starting point. 

This parameter is set to the resolution of the encoder in CTS/Unit. 

The home mode selects whether the home input comes discrete input #5 or over 
fieldbus (hardware option). 

Condition Description 

Digital Input # 5 Home input comes from digital input nb. 5. 

Bus Home input comes from a bit vie fieldbus. This option is 
available for HACD-DPQ with fieldbus interface only. 

 

This will setup the type of zero pulse being used if the encoder has a Z channel. The 
Z channel is always "anded" with the home mode input. 

Condition Description 

NON No Z channel is used. 

RISING The rising edge of the zero pulse is used. 

FALLING The falling edge of the zero pulse is used. 
 

This will invert the sign on the position feedback. 

Condition Description 

INC Forward counting pulses will increase the feedback signal. 

DEC Forward counting pulses will decrease the feedback signal.
 

 

Mode 

Home Offset 

Resolution 

Home Mode 

Zero Channel 

Direction 
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BUS Manager (Profibus, CANopen, DeviceNet) 

In the Screen „Busmanager“ you set the parameters for the bus communication and 
you choose which parameters will be transmitted via bus. 

Exemplary the Profibus is described. 

 
Fig. 18 Screen "Profibus Hardware" window 

 

The file menu in the “Profibus” window corresponds to the BODAC main window “file 
menu ". 

Incudes commands for reading, writing and changing of parameters. 
 

Leads you directly to help on the current topic or to the index page of the BODAC 
Windows Help. 

Icons are provided for functions that are frequently used. They are described in “icon 
bars of a window ". 

 
The window shows bus parameters, which can be changed, if applicable.  

 
Determination of the parameters to be sent from the controller card to the bus master 
(e.g. PLC) 

Profibus –  
File menu 

Profibus –  
Controller menu 

Profibus –  
Help menu  

Profibus –  
icon bar 

Send 
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Fig. 19 "Profibus, transmit parameter HACD -> PLC" window 

The File menu in the window "Profibus" corresponds to the BODAC main window "File 
menu". 

Includes commands for reading, writing and changing of parameters. 
 

Leads you directly to help on the current topic or to the index of the BODAC Windows 
Help. 

Icons are provided for functions that are frequently used. They are described in “icon 
bars of a window. 

 

The selection box "Parameters" lists all parameters that are available in the HACD. A 
maximum of 32 bytes can be transmitted via Profibus DP V0. These are subdivided 
into 4 buffers. 

 

Adds parameters from the selection list for bus transmission. 

 

Removes parameters from the bus transmission. 

 

Send Profibus HACD->SPS – 
File menu 

Send Profibus HACD->SPS - 
Controller menu 

Send Profibus HACD->SPS–  
Help menu 

Send Profibus HACD->SPS –  
Icon bar 
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If parameters, which are available in several blocks, are selected for 
transmission via bus, the block number must be selected additionally. 

 

Determination of the parameters to be received by the controller card (HACD) from 
the bus master (e.g. PLC). 

 
Fig. 20 "Profibus, receive parameter PLC -> HACD" window 

The File menu in the window "Profibus" corresponds to the BODAC main window "File 
menu". 

Includes commands for reading, writing and changing of parameters. 
 

Leads you directly to help on the current topic or to the index of the BODAC Windows 
Help. 

Icons are provided for functions that are frequently used. They are described in “icon 
bars of a window. 

The selection box "Parameters" lists all parameters that are available in the HACD. A 
maximum of 32 bytes can be transmitted via Profibus DP V0. These are subdivided 
into 4 buffers. 

 

Adds parameters from the selection list for bus transmission. 

Receive 

Receive Profibus PLC 
->HACD – File menu 

Receive Profibus PLOC 
->HACD – Controller menu 

Receive Profibus PLC 
->HACD – Help menu 

Receive Profibus PLOC 
->HACD – Icon bar 
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Removes parameters from the bus transmission. 

 

 

If parameters, which are available in several blocks, are selected for 
transmission via bus, the block number must be selected additionally. 
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4.5 Tools menu 

In the "Tools" menu is used to configure BODAC for communicating with the controller 
card depending on the users preferences. 

 
Fig. 21 Tools menu 

Communication interface between the PC and controller card, the access authoriza-
tion and the behavior for data synchronization with the controller card can be specified 
in the "Preferences" submenu. 

The Utilities submenu contains update functions and an option for resetting the con-
troller card to its factory settings. 

 

Preferences 

The "COM" window is the dialog window for configuring the serial port. 

 
Fig. 22 "COM" window 

With the "Serial Port" entry field the user specifies which serial port of the PC is used 
to communicate with the controller card. 

In the "Timeout" field you determine how much time BODAC waits until generating the 
"Unable to Connect" warning. 

 

Com 

Serial Port 

Timeout 
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The "Options" window defines the frequency and type of data transmission to the 
controller card. 

 
Fig. 23 "Options: General Settings" window 

The user can select the desired field by placing a checkmark and the selection has to 
be confirmed with the "OK" button. 

 
Fig. 24 "Options: Fault monitoring" window 

In the "Fault Monitoring" tab the time interval can be selected for monitoring the faults 
that are shown in the "Status" window (see also "Status"). 

Example: A time of (1000 ms) means the fault status is updated every second. 

Options 
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Five security levels are available for using BODAC. This allows the BODAC users to 
be divided into groups ensuring that only qualified and trained personnel can change 
critical settings. 

The security levels are defined as follows: 

 Level 4 = Rexroth Bosch AG 

 Level 3 = Rexroth Bosch AG 

 Level 2 = Customer (Default: 2) 

 Level 1 = Customer (Default: 1) 

 Level 0 = Customer 
 
Default for level 1 and 2 can be changed by customer. 

 

WARNING!  

 
The restrictions in changing parameters and process data have been 
created for your own security! 

Never attempt to circumvent the security levels through program 
manipulation or changes of any kind. 

Personal injury and severe damage to equipment may result when 
the controller card no longer operates properly due to unauthorized 
manipulation. 

This will also result in loss or warranty provision and/or liability on 
the part of the manufacturer! 

 

 

Document the Passwords for all levels (Customer and Bosch Rexroth 
AG). 

 

The BODAC software always starts up in Level 0. 

The user logs in from the "Login" window by entering the password he has received 
for his user group. After successful login, any setting or parameter change allowed for 
this group can be made. 

 
Fig. 25 "Login" window 

 

Security 

Login 
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The "Passwords" window is where the password is assigned to the defined security 
levels. 

 
Fig. 26 "Passwords" window 

 

The "Configure Screen Security" window allows the user to specify which user group 
shall have access to the various BODAC screens. 

 
Fig. 27 "Configure Screen Security" window 

The fields are used to assign security levels per window. Use the "View" and "Set" 
columns to determine which user group has view-only privileges for certain windows 
and which group is allowed to change parameters. 

 

Passwords 

Configure Screen Security 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

46/108 Bosch Rexroth AG  |  Hydraulics VT-HACD-DPQ  |  RE 30146-01-B/11.06 

4 BODAC – Menu Description 

 

Utilities 

Program changes (updates) for BODAC are in the form of files having extensions: 

 .hcd 

 .jmt 

 .pkg 
 
Clicking on the menu item "Send firmware" allows you to select the update file in the 
resulting "Open" window. The BODAC program guides you through the successive 
steps until the program changes have been completed. 

The "Read HCD File From Memory" command generates a file of the entire controller 
card structure. 
BODAC automatically generates this file. 

Resets the values and parameters for the controller card back to their default settings. 

 

WARNING!  

 
Resetting the values and parameters on the controller card to factory 
default results in loss of all data previously entered! 

 

Send firmware 

Read HCD File From Memory 

Use Default Parameter Data 
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4.6 Application Screens menu 

The "Application Screen" contains entry menus which are specially constructed for 
position-dependent braking applications. 

 
Fig. 28 Application Screens menu 
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The HACD-DPQ main menu 

Opens the HACD-DPQ main menu, which contains all the required menus for the 
"Injection control for injection molding machines" application described in section 5. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Main menu DPQ" window. A listing of existing short-
cuts for the toolbar can be found in Section "Toolbar". 

or 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Main menu DPQ analog" window. A listing of existing 
shortcuts for the toolbar can be found in Section "Toolbar". 

See also: Section "HACD-DPQ Main menu" 

 

IN/ OUT Config 

Opens the "In/Out configuration" window for configuration the analog and digital I/Os. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "In/Out cfg" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar". 

See also: Section 5.4 "Configure inputs and outputs". 

 

Injection 

Opens the "Injection" window for parameterizing the injection phase. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Injection" window. A listing of existing shortcuts for the 
toolbar can be found in Section "Toolbar". 

See also: Section 5.5 "Configure profiles for injection". 

 

Pack and hold 

Opens the "Pack and hold" window for parameterizing the pack and hold phase. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Pack and hold" window. A listing of existing shortcuts 
for the toolbar can be found in Section "Toolbar". 

See also: Section 5.5 "Configure profiles for pack and hold". 
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Back pressure 

Opens the "Back pressure" window for parameterizing the back pressure phase. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Back pressure" window. A listing of existing shortcuts 
for the toolbar can be found in Section "Toolbar". 

See also: Section 5.5 "Configure profiles for back pressure including pre- and post-
decompression". 

 

Loop Tuning 

Opens the "Loop Tuning" window. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Loop Tuning" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar". 

or 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Loop Tuning analog" window. A listing of existing 
shortcuts for the toolbar can be found in Section "Toolbar". 

See also: Section 5.4 "Adjust controller parameter for velocity and pressure for inter-
nal mode" or "Adjust controller parameter for velocity and pressure for analog mode". 

 

Spool config 

Opens the "Spool config" window for parameterizing the flow characteristic of the Q-
spool. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Spool Config" window. A listing of existing shortcuts 
for the toolbar can be found in Section "Toolbar". 

See also: Section 5.4 "Configure spool flow curve". 

 

2 valve / Bus option 

Opens the "2 valve / Bus option" window for further options. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "2 valve / Bus option" window. A listing of existing 
shortcuts for the toolbar can be found in Section "Toolbar". 

See also: Section 5.4 "2 valve / Bus option". 
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Motion Data 

Opens the "Motion data" window for monitoring all signals in real-time. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Motion data" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar".  
Different screens will be opened depending if Analog Mode or Inter-
nal/Bus Mode was choosen. 

See also: Section 4.6 "Motion data". 

 

Jog Mode 

Opens the "Jog mode" window for parameterizing the open loop jog mode. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Jog mode" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar". 

See also: Section 5.4 "Configure velocity for jog mode". 

 

Bus Trigger 

Opens the "Bus Trigger" window for checking the settings of the triggers set via bus 
system. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Bus Trigger" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar". 

See also: Section 4.6 "Bus Trigger". 

 

 

Controller Structure 

Opens the "Controller Structure" window for checking the values of controller settings. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Controller Structure" window. A listing of existing 
shortcuts for the toolbar can be found in Section "Toolbar". 

See also: Section 4.6 "Controller Structure". 
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Test jacks 

In the "Test jacks" window the signals can be assigned which you can measure for 
diagnostic purposes on diagnostics terminal "X2" on the front panel of the HACD. 

The "Valve command" signal is permanently assigned to test jack "X1". 

You can assign a signal corresponding to the selection menu to test jack "X2" (see 
Fig. 29 "Test jacks" window). 

The tabular window shows the signal flow from left to right with the necessary entry 
fields. 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Test jacks" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar". 

 

 
Fig. 29 "Test jacks" window 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

Clicking on the Signal entry field opens a selection menu which contains the available 
signals. 

Test jack "X1" has a pre-assigned value of 100 units, but you can adjust the size of 
the unit [Unit] for "X2". 

 

 

For additional information on the test jacks of the card, see Technical 
Bulletin RE 30146-B "Installation and Operation of the Controller 
Card". 

 

Test jacks - 
Help menu 

Signal 

Unit 
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Motion Data 

The "Motion Data" window shows the entire signal sequence for the controller card in 
real-time. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Motion Data" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar". 
Different screens will be shown, depending if Analog Mode or Inter-
nal/Bus Mode is choosen. 

 

 
Fig. 30 "Motion Data" window for Internal/Bus Mode 
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Fig. 31 "Motion Data" window for analog Mode 

 

 

 

Depending which Mode is chosen the accordant Motion Data screen 
appear. 

 

 

 

Clicking on the preceding icon, which is also a component of the tool-
bar, opens the window "Multiplot".  

 

Clicking on the preceding icon, which is also a component of the tool-
bar, starts the recording of all signals shown in the multiplot window 
with every Block change.  

 

Clicking on the preceding icon, which is also a component of the tool-
bar, opens the window "WinView recording“ 

 
 

The upper third displays the current operating status of the HACD-DPQ control elec-
tronics. 
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Below that is an overview of all necessary parameters for the input and output vari-
ables. 

The lower third of the window shows the digital in-/outputs with their current state on / 
off. 

 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

Description of the signals: 

Represents active phase of injection control (Injection, Jog mode, Back pres, Decom-
press). 

Represents the internal state of the controller card (Stop, Pause, Active). 

Represents the active block of the internal structure. Following is a complete lsit what 
is done in every block. This can also be used on the PLC to determine in what state 
the card will be. 

Block 
Nb 

Analog Mode Internal Mode 

1 - Inject Profile Step 1 
2 - Start Inject / Jog + 
3 - Inject Profile Step 2 
4 - Inject Profile Step 3 
5 - Inject Profile Step 4 
6 - Inject Profile Step 5 
7 Analog Passthrough / Start/Stop Analog Passthrough / Start/Stop 
8 - Start Post Decompress / Jog - 
9 Start Analog Inject Transfer Optimisation 

10 Analog Inject - 
11 - Transfer Hydraulic Pressure 
12 - Transfer Cylinder Position 
13 - Holding Pressure Step 1 
14 - Holding Pressure Step 2 
15 - Holding Pressure Step 3 
16 - Holding Pressure Step 4 
17 - Holding Pressure Step 5 
18 - Jog Forward 
19 - Jog Retract 
20 - Back Pressure Step 1 
21 - Back Pressure Step 2 
22 Analog Transfer for Holding Pressure - 
23 - Pre Decompress 
24 - Back Pressure Step 3 
25 Analog Transfer for Back Pressure Decompress Complete / Fault 
26 - Inject Profile Step 6 
27 - Inject Profile Step 7 
28 - Inject Profile Step 8 
29 - Inject Profile Step 9 
30 - Inject Profile Step 10 
31 - Post Decompress 

Process display - 
Help menu 

Output Mode 

Program Status 

Program Block 
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32 - Transfer External Signal 
 

Mode 1: Inject     white 
Mode 2: Jog Mode    green 
Mode 3: Pack and Hold / Back Pressure yellow 
Mode 4: Decompression   red 

 

 

 

In Analog Mode the Decompression settings are not used. For decom-
pression the Passthrough function is used in the Analog Mode. 

 

 

Represents the analog command value of the velocity. This value is valid in analog 
mode only. 

Represents the analog position feedback signal. 

Represents the internal command value of the velocity. 

Represents the SSI position feedback signal. 

Represents the loop error of the position controller. 

Represents the analog command value of the velocity. This value is valid in analog 
mode only. 

Represents the pressure feedback signal of pressure transducer #1. 

Represents the pressure feedback signal of pressure transducer #2. 

Represents the pressure feedback signal of pressure transducer inside the mold (ac-
tual cavity pressure) 

Represents the internal command value of the pressure 

Represents the internal pressure feedback which is used for the pressure controller 

Represents the loop error of the pressure controller. 

Represents the output to the control valve. 

Represents the value at output 2. See 2 valve / Bus option. 

Represents the value at output 3. See also 2 valve / Bus option. 

Represent the digital inputs and outputs. 

Represents the values at spare inputs and outputs if used as analog I/O via bus 
communication. See also valve/ Bus option 

Represent the control bits via bus. 

Velocity CMD 

Position 

Vel Loop CMD 

Position FB 

Position Error 

Pressure CMD 

Pressure FB#1 

Pressure FB#2 

Cavity Pressure 

Press Loop CMD 

Pressure FB 

Pressure Error 

Valve Output 1 

Valve Output 2 

Valve Output 3 

Digital I/O 

PLC Option 

Bus Option 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30146-01-B/11.06  |  VT-HACD-DPQ Hydraulics  |  Bosch Rexroth AG 57/108 

BODAC – Menu Description 4 

 

 

 
 

 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

58/108 Bosch Rexroth AG  |  Hydraulics VT-HACD-DPQ  |  RE 30146-01-B/11.06 

4 BODAC – Menu Description 

 

Multiplot 

In the multiplot window the signal trace of selected signals are represented in graphi-
cal form. 

 
Fig. 32 "Multiplot" window 

The window is a convenient software representation of an oscilloscope. 

You can get to the "Multiplot" window from any submenu in the "Application Screens" 
menu. 

 

 

The real-time oscilloscope is used mainly in the "Motion Data" window 
(see section "Motion Data"). 
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Multiplot toolbar 

This toolbar contains buttons with which all the functions of the Multiplot can be exe-
cuted. 

 
Fig. 33 Multiplot – Toolbar 

The following functions are available: 

 

"Save": signal traces can be saved as a file with the ".plt" extension. 
The file can be loaded again as needed. You can also import the file 
into Excel. 

 

"Open": previously saved signal traces can be loaded into the Multiplot 
window. 

 

"Open": previously saved signal traces can be loaded into the Multiplot win-
dow. The new signal trace is superimposed over the existing one. 

 

"Run": starts the recording and displaying the Multiplot selected sig-
nals. 

 

"Pause": stops recording the signal and freezes the display until it is 
reactivated using the "Run" button. 

 

Chart Recorder Mode: Moves the signal display from right to left. The 
signal trace is shown as a moving band. 

 

Scope Mode: Anchors the signal display. The signal trace starts on the 
left and ends at the right edge in constant repetition. 

 

All selected signals are shown together in one graph. 

 

Each signal is shown individually. 

 

Generates a screenshot of the current representation of the Multiplot.  
Opens the "Save file as" window where you can save the signal trace 
in a "Windows Meta File". 
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Opens the "Print" window. You will receive a printout of the Multiplot. 

 

"Add": Opens a window in where analog and digital signals can be 
added using two selection menus. 

 

"Delete": Opens a window in which you can delete a selected signal 
from the Multiplot window. 
To delete a signal you have to click on the name of the desired signal 
in the "Signal Display" legend. 
The signal is then displayed with a white background. Non-selected 
signals are displayed with a gray background. 

 

"Show Cursor": Puts two cursors on the signal trace of the displayed 
signals. By selecting a signal in the "Signal Display Legend", you can 
use the mouse or the left/right arrow keys to position the trace as de-
sired. 
The coordinates are shown in the "Signal Display Legend" as X and Y 
coordinates. 

 

"Hide Cursor": Removes the cursors from the display. 

 

"Trigger": Opens a window in which you can set the trigger condition 
for displaying the trace. A selection menu allows you to set the trigger 
condition. Enter the value in units [Unit] for the trigger level. 

1 s/div The signal display division is shown by green grid lines in the X-Y 
coordinates. Change the X-coordinate divisions by clicking on the 
preceding field. In the present display the signal will travel 1 grid field 
in the X direction in one second. To learn how to configure the Y-
coordinate, see Section "Multiplot Display Legend". 

 

Increase the in the time base set value one step up. With the actual 
setting of 1 s/div the x-axis will increase to 500 ms/div. 

 

Decrese the time base value for one step. With the actual setting of 1 
s/div the x-axis will decrease to 2 s/div. 

 

The with the mouse cursor framed area will be increased to the whole 
area of the process indication. 
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Decrease the signal setting to the original frame/size. 

 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

62/108 Bosch Rexroth AG  |  Hydraulics VT-HACD-DPQ  |  RE 30146-01-B/11.06 

4 BODAC – Menu Description 

 

Multiplot Display 

The signal display is a graphical representation of the signal over time. 

 
Fig. 34 Multiplot – signal display 

The distance is shown in the Y-direction. The unit for the displayed velocity is units 
per second. The X-direction is represented as a time axis.  

The representation corresponds to a standard oscilloscope. 

 

Multiplot Display Legend 

The signal display legend shows the relevant information for the displayed signals in 
column format. 

 
Fig. 35 Multiplot – Signal display – Legend 

In the Parameters column the signals are shown with their names. Clicking on a signal 
name changes the background to white. This means the signal is selected. 

Double-clicking on a signal name opens the "Adjust graphs" window. 

 
Fig. 36 "Adjust graphs" window 

Parameters 
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The "Adjust Graphs" window is used to change the display of the selected signal. 
Clicking on the "Color" field opens a color table in which you can select a new display 
color. 

The "Weight" field contains a selection menu for changing the line thickness of the 
signal. 

Set the scaling in the Y-axis of the signal display for the selected signal in the "Min" 
and "Max" entry fields. 

The current parameter value is shown in the signal display legend after the signal 
name. 

The Color column contains the display color for ensuring association and recognizabil-
ity in the signal display 

Columns "X1" and "Y1" are directly related to the "Show cursor" button. By moving the 
cursor for Marking 1 to a particular point in the trace you can read off the X-Y coordi-
nates of the displayed signal in the X1/Y1 column. 

Lists the coordinates of Marking 2 in the "X2"/"Y2" column. 

The "dX" and "dY" columns display the increase/decrease of the trace. 

Color 

X1/Y1 

X2/Y2 

dX/dY 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

64/108 Bosch Rexroth AG  |  Hydraulics VT-HACD-DPQ  |  RE 30146-01-B/11.06 

4 BODAC – Menu Description 

 

 

Winview recording 

 

 
Abb. 1 “Winview Recording” window 

 

The File Menu in the „Winview Recording“ window corresponds to the BODAC main 
window „File menu“. 
 

Takes you directly to the help function for the current topic, or the contents page of the 
BODAC windows help. 

Buttons are provided for frequently used functions. These are described in section 
„Toolbar“. 

 
The signals listed in this screen are the same signals used in the BODAC Structure 
Editor. The Structure Editor screen layout is used to categorize the different signals 
that can be recorded in an easy to understand representation  

Further information regarding the signals used in BODAC that can be selected for 
recording can be found in the chapter Motion Data. 

 

This setup allows the user to select the condition that will trigger the start of the re-
cording. 

This setup is used for configuring the recording parameters. The number of recording 
points for all signals combined is limited to 16384. 
The rate of recording can be set between 2ms and 32766ms. Since the smallest 
available time step for recording is 2ms the number entered here should be a multiple 
of 2.  
The Pretrigger points have a range of 0 – 16384 ms.  

Winview Recording –  
File menu 

Winview Recording –  
Help menu 

Winview recording –  
Toolbar 

Trigger Setup 

Recording Setup 
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Status 

The "Status" window provides an overview of the current faults which were detected 
while the HACD-DPQ was operating. 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "Status" window. A listing of existing shortcuts for the 
toolbar can be found in Section "Toolbar". 

 

 
Fig. 37 "Status" window 

Remains green as long as no fault has been detected. 

Remains yellow when a fault has been detected. If a signal you want to monitor is set 
to "Flag" in the "Faults" window, operation of the card is not interrupted. The fault is 
recognized, saved and processing continues. 

Comes on red when a fault has been detected. The controller card stops the process. 
Set the monitored signal in the "Faults" window to "Stop". 

Fault scheme for analog inputs 1 through 6. 

SSI encoder error. The settings for the SSI are made in the "SSI" window (See section 
"SSI"). 

The Incremental encoder has a fault at channel A. 

The Incremental encoder has a fault at channel B. 

If the frequency is too high for the incremental encoder an error occurred (See chapter 
4.4 Incremental). 

OK 

Marker 

Stop 

AI 1 to 6 

SSI 

Encoder Channel A 

Encoder Channel B 

Max. Freq. Fault 
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The checksum for the memory chip shows a deviation from the currently stored data 
in the chip.  

Error indication, that the RAM chip in the controller card is defective. 

An error is indicated if the supply voltage is absent or incorrect. (short circuit or effect 
of other connected consumers) 

A fault is indicated if the reference voltage +/-10 on the edge connector deviates by 
0.5 %. 

Error indication for digital outputs 1 through 7 when there is a short circuit on one of 
the outputs. 

Error indication for a bus fault. In general it mean that the bus has left the operaional 
communication state. But depending of the Bus System it has different meanings. 
Profibus: The slave has left condition “DATA_EXCHANGE”.  
CANopen: The node has left the condition “OPERATIONAL”.  
DeviceNet: The node has left the condition “ONLINE”. 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

 

 

Checksum flash 

Memory 

24 V Power  

+/-10V / 5V Source  

Short circuit DO1 to DO7 

Bus Fault 

Status –  
Help menu 
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Bus Trigger 

The Bus Trigger screen will only be visible if the Bus Mode is chosen. It shows the 
actual status of the bus triggers. With it you can see and control what bit is set via the 
bus for the triggers because every block has its own bit. Please check this screen 
when you are having trouble to set the triggers via bus from the PLC. 

 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Test jacks" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar". 

 

 
Fig. 38 "Bus Trigger" window 

 

 

Only visible in security level 2 and is Bus Mode is chosen in In/Out 
Config screen. 
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Controller Structure 

The Controller Structure screen will show the actual status of the controller values 
inside the card. With it you can see what value each controller part has. This will help 
to do the controller settings for the DPQ. 

 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Controller Structure" window. A listing of existing 
shortcuts for the toolbar can be found in Section "Toolbar". 

 

 
Fig. 39 "Controller Structure" window 
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4.7 Window menu 

The Window menu contains commands for saving and opening specified window 
arrangements. You can directly select already opened windows from here. 

 
Fig. 40 Window menu 

When BODAC is first started up and after the program has been loaded, only the main 
window is opened. The "Save layout" function saves your current appearance of BO-
DAC with all the currently opened windows and window positions in a file. This allows 
you to save preferred window combinations for working with BODAC and open them 
at any time as needed. 

Already opened windows (e.g., Analog I/O, see Fig. 40 Windows menu) can be se-
lected by a simple mouse click. This allows you to navigate quickly through opened 
windows. 

The "Save layout" function saves the current layout of BODAC with all the currently 
opened windows and window positions in a file. This allows you to save preferred 
window combinations for working with BODAC and open them at any time as needed. 

Opens a window in which already saved layouts of BODAC can be recalled. BODAC 
restores the saved window combination after opening the file. 

Select opened window 

Save layout 

Open layout 
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4.8 Help menu 

Go to BODAC online help as follows: 

 Press the F1 key 

or 

 Click on the Topics menu in the Help menu 

or 

 Click on the Help button in the active window 

 

 
Fig. 41 Help menu 

In addition, an info text is displayed on the element below your mouse cursor. 

 

About BODAC… 

This is an information window which provides information about the version and origin 
of BODAC. 

 

Topics 

Opens a summary of BODAC online help. From this contents window the user can 
navigate to any area and any available knowledge topic. 

 

Example 

Opens online help for the application (see section 5 "Injection control for injection 
molding machines"). 
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5 Application: Controller for injection molding 
machines 

5.1 Startup reference list 

 The BODAC Software. 

 Data exchange between the BODAC software and the HACD-DPQ closed-loop 
controller electronics. 

 Open or create parameter file. 

 Save the working state. 
 

 Choose mode of the controller card (intern, analog or bus) 
 

 Configure inputs and outputs: 

– Choose maximum values 
– Choose position feedback signal 
– Choose pressure transducers and pressure controller mode 
– Adjust digital outputs  

 
 Configure Q-spool flow curve. 

 Adjust controller parameter for velocity and pressure: 

– for internal or bus mode or 
– for analog mode 

 
 Configure velocity for jog mode. 

 
 Check wiring with jog mode. Double check if valve and feedback signals are cor-

rect. 
 

 Configure profiles for injection. 

 Configure profiles for pack and hold. 

 Configure profiles for back pressure including pre- and post-decompression. 
 

 Save parameter file 
 

 Check your actual values 

– Motion Data 
– Test jacks 
– Status overview 

 
 Start application 

 

 

Using software for startup 

Select mode 

Adjust configuration 

Check wiring 

Define profiles for internal or 
bus mode 

Save the working state 

Process settings 

Starting the application 
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5.2 Establish communication 

Data exchange between the BODAC software and the HACD-DPQ closed-loop controller 
electronics 

Establish an RS-232 connection between the PC and the HACD-DPQ so the desired 
data can be set, saved and duplicated. 

A fixed baud rate is set in the card. 

 Connect PC to HACD-DPQ using an RS-232 cable (1:1 cable). 
Required cable set: VT-HACD-1x/03.0/HACD-PC 

 Turn on PC and HACD-DPQ. 

 Install BODAC. 

 Start BODAC (see section 3 "BODAC user interface"). 

 

Open or create parameter file 

The card is set up for an application. The data for adapting and structuring the appli-
cation are saved in a file (FILENAME.PARAM) and stored in the predefined directory 
\user\. 

Assign a file name and save the current application state. 

 

 

If there are no parameter files, the user is prompted after program start 
to open a default file. 

 

 

 

See section "Open". 

 

 

 

 

See section "Save". 

 

 

Open parameter file 

Create parameter file 
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5.3 Select mode 

Mit dem Mode erfolgt die Umschaltung der Betriebsarten der HACD_DPQ. 

 Access to this screen is allowed at security level 2 only. 

 

 

INTERN The injection phases (Injection, Pack and Hold and Back Pressure) 
are defined in the subsequent HACD-DPQ profiles. The selecton of 
the profiles is realized through Digital Inputs as well as through 
internal trigger events. Auto (DI2) has to be active (Active High) to 
start this Mode. 

BUS The injection phases (Injection, Pack and Hold and Back Pressure) 
are defined in the subsequent HACD-DPQ profiles. The selecton of 
the profiles is realized through BUS triggers as well as through 
internal trigger events. Auto (DI2) has to be active (Active High) to 
start this Mode. 

ANALOG The setpoint is an analog signal connected to an analog input. Digi-
tal inputs start the separate phases (Injection, Pack and Hold and 
Back Pressure and Screw Decompress). 

Auto (DI2) has to be inactive (Active Low) to start this Mode. 
 

This pulldown is only visible, if in “Choose Mode” Bus is set. 

DI3 The transfer from Injection to Pack and Hold is triggered via the 
discrete input DI3. 

BUS The Transfer from Injection to Pack and Hold is triggered via bus 
system. 

 

 

Choose Mode 

Transfer Trigger 
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5.4 Adjust configuration 

Configure inputs and outputs 

In the "Configure inputs and outputs" menu you select the signals for the inputs and 
outputs for your application. 

 Access to this screen is allowed at security level 2 only. 

 

 

Clicking on the preceding icon, which is a component of the toolbar, 
also opens the "In/Out Cfg" window. A listing of existing shortcuts for 
the toolbar can be found in Section "Toolbar". 

 

 
Fig. 42 "Configure inputs and outputs" window 

The File menu in the "Config.Input.Velocity" window corresponds to the BODAC main 
window "File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

In/Out Cfg 

In/Out Cfg –  
File menu 

In/Out Cfg –  
Controller menu 

In/Out Cfg –  
Help menu 
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General Config. 

Set to the maximum length of the position feedback transducer.  

In Analog Mode the velocity command is presented to the controller as an analog 
signal. This value corresponds to the maximum velocity related to a 100% command. 

Set to the maximum value of the pressure feeback transducer(s). 

The value Pres Max Inject is copied tor all these parameters if BODAC is used. If a 
BUS is used to set Pres Max inject then all 4 values have to be set seperately. These 
values are displayed for information. 

Defines the position feedback type. 

ANALOG Select ANALOG if you are using an analog positon transducer with 
voltage or current interface connected to IN 5 

SSI Select SSI if you are using a SSI digital position transducer. 

INCR Select INCR if you are using an incremental positon transducer. 
 

Attention!  

 
The conditioning electronics for the Incremental Encoder has a 
maximum detection frequency of 100 kHz. If this frequency is ex-
ceeded the actual position will not be decoded properly. 

When using this type of encoder the user needs to choose the 
maximum velocity such that, keeping the resolution of the encoder 
in mind, the maximum frequency of 100 kHz is not exceeded. 

 

For force control instead of pressure control this value determines the ratio of the 
cylinder areas. Two pressure transducers are necessary. 

For pressure control with one pressure transducer this value is irrelevant. 
This factor compensates for different areas in the extend/retract directions of the injec-
tion hydraulic cylinder. This allows the DPQ to limit the actual force of the cylinder, 
allowing for area differences. 
The default is –1.0.  

Ratio >= 1  
OR  
-1 < Ratio < 0

 
     Force = (Transducer#1 * Ratio) – Transducer#2 

Ratio <= -1 
OR 
0 < Ratio < 1 

 
     Force = Transducer#1 – (Transducer#2 / Ratio) 

This parameter is only useful in a hydraulic system that uses a proportional directional 
type flow valve with a non-injection type spool to control both velocity and pressure. If 
the hydraulic system uses an injection valve or seperate valves for flow and pressure 
then set this parameter to –1.0. 

 

Pos Max Length 

Analog Vel Max 

Pres Max Inject 

Pres Max Back Press 
Pres Max Jog 

Pres Max Decomp 

Choose Position Feedback 

Cyl. Area Ratio 
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Discrete Outputs 

This output indicates if injection or pack and hold mode is active. Choose between 
high or low active. 

This output indicates if back pressure mode is active. Choose between high or low 
active. 

This output indicates if injection mode is active. Choose between high or low active. 

This output indicates if the actual pressure has reached a certain pressure level (At 
Press Level). This level has to be reach for a minimum of time (At Press Delay).  

 

Pressure Control 

OPEN LOOP Open loop pressure controller. Please set all P gains to 1 
and all integrals to 0.  
The closed loop control may be turned off for initial setup 
and troubleshooting purposes. If the DPQ is controlling 
the pressure profile using a pressure type proportional 
valve connected to valve output 2 then the pressure loop 
may be left in open loop. PID tuning is not required in 
open loop control and the resultant control may be ac-
ceptable depending on the type of pressure control valve 
and the system configuration. 

CLOSED LOOP 1 PT Closed loop pressure controller with 1 pressure trans-
ducer 

CLOSED LOOP 2 PT Closed loop pressure (force) controller with 2 pressure 
transducers. Cyl. Area Ratio has to be set. 

 

Buttons 

These buttons give the user a fast and comfortable way to access several windows 
directly from the current window. 

Opens the "Analog I/O" window for configuring the analog inputs.  
See also: Section "Analog I/O". 

Opens the "SSI" window for configuring the SSI input.  
See also: Section "SSI". 

Opens the "Incremental" window for configuring the incremental input.  
See also: Section "Incremental". 

Opens the "2 valve / Bus option" window for configuring the 2-valve mode and som 
options. 
See also: Section "2 valve / Bus option". 

 

Configure spool flow curve 

A proportional valve with integrated electronics and Q-type spool is recommended for 
injection control. This allows for implementing pressure control by using a single pres-
sure transducer. 

DO 1 

DO 3 

DO 4 

DO 7 

Open/Closed Loop 

Analog Cfg 

SSI Cfg 

INCR Cfg 

2 valve Inject.Sys 
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Access to this screen is allowed at security level 2 only. 

 

 

 
Fig. 43 "Spool configuration" window 

The File menu in the "Q-spool Config" window corresponds to the BODAC main win-
dow "File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

Spool config –  
File menu 

Spool config –  
Controller menu 

Spool config –  
Help menu 
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Compensates for the flow curve of the spool during different modes of operation. 

Enter the required gain factor for the controller output value to the valve. This parame-
ter is used to rescale the control loop output range for improved resolution when off-
sets and limits are applied. The scale factor is applied anytime a corresponding seg-
ment is selected. This parameter is direction dependent. 
The standard setting is 1.0. This parameter shoul be adjusted so that the full range of 
the valve output is 100% of the control loop. For example, if the valve offset is set to 
10%, the valve output will reach 100% with only 90% loop output, effectively increas-
ing the loop gain. In this example, the remaining 90% of valve output can be scaled to 
100% loop output by applying a multiplication factor of 0.9. This parameter value 
should normally be set to 1.0 or lower. 

Offset to valve output#1, in percent of full scale. This parameter is used to improve the 
response of the control loop when using overlapped or injection type valve spools. 
The offset is applied anytime a corresponding segment is selected. This parameter is 
direction dependent. 
This parameter should be adjusted to closely match the valve spool flow characteris-
tic. Set the offset value to be slightly less than the overlap of the spool, so the injection 
cylinder does not drift when the machine is idle. 

Enter the maximum value to limit the controller output value to the valve. 
This parameter can be adjusted to limit the direction of the valve output in the forward 
direction.  
Jog Mode and Decompression should be set to +100%, so over center operation is 
possible in these modes. 

Enter the minimum value to limit the controller output value to the valve. 

When using an injection type valve set this value to prevent the pressure integrator 
from shifting the valve into the decompression range of operation during Mold fill, 
Pack and Hold and Back Pressure. 
Jog Mode and Decompression should be set to –100%, so over center operation is 
possible in these modes 

These buttons will give the user an overview of the flow charateristics of the most 
commonly used spools. 

 

 

The exact data used for Scale, Offset and Limit can be found in the 
actual RE datasheet of the corresponding valve. 

In Back Pressure the Limit + parameter is automatically set to zero to 
prevent the injection cylinder from actively advancing 

 
 

 

 

In Analog Mode the Decompression settings are not used. For decom-
pression the Passthrough function is used in the Analog Mode. 

 

 

Scale 

Offset 

Limit + 

Limit – 

Buttons for           Q1 Spool 
Q2/3/4 Spool 

V Spool 
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The following example shows the flow characteristic of a Q2, Q3 and Q4 spool. 

The values for Scale, Offset, Limit+ and Limit- are displayed for the different Injection 
phases. It is not unlikely that these values need to be fine-tuned during commission-
ing. 

 
Fig. 44 Q-type spool settings 

 

Example: Q2/3/4 Spool 
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Adjust controller parameter for velocity and pressure for internal mode 

All the necessary control loop settings can be made with the control parameters. The 
values entered affect the loop behavior.  

 

Access to this screen is allowed at security level 1 only. 

 

 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Loop Tuning" window. A list of existing shortcuts for 
the toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 45 "Loop Tuning" window for internal and bus mode 

The File menu in the "Parameters" window corresponds to the BODAC main window 
"File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Loop Tuning 

Loop Tuning –  
File menu 

Loop Tuning –  
Controller menu 
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Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

Controller parameters for the velocity controller during injection. 

Velocity P This parameter changes the proportional component of the 
velocity controller. It causes a proportional change in the out-
put component. See also "Controller structure". 

Velocity D This parameter changes the derivative component of the ve-
locity controller. It causes a differentiated response of the 
output signal corresponding to the rate of change of the input 
signal. See also "Controller structure". 

Vel. Active Damp-
ing 

This parameter changes the gain of the active damping path. 
See also "Controller structure". 

 

Parameters for the pressure controller and the pressure rates during pack and hold. 
The Pressure PID parameters are also active during the injection velocity profile. 

Pressure P This parameter changes the proportional component of the 
pressure controller. It causes a proportional change in the 
output component. See also "Controller structure". 

Pressure I This parameter changes the integral component of the pres-
sure controller. It causes a velocity change in the output signal 
proportional to the time integral of the input signal. See also 
"Controller structure". 

Pressure D This parameter changes the derivative component of the pres-
sure controller. It causes a differentiated response of the out-
put signal corresponding to the rate of change of the input 
signal. See also "Controller structure". 

 

Active damping for pressure loop 

Frequency This parameter changes the frequency of the filter of the active 
damping path. See also "Controller structure". 

Gain This parameter changes the gain of the active damping path. 
See also "Controller structure". 

 

Pressure rate This parameter defines the Ramp time for an increase in pres-
sure command. See also "Creating command values with 
ramps". 

Decomp. rate This parameter defines the ramp time for a decrease in pres-
sure command. See also "Creating command values with 
ramps". 

 

Loop Tuning –  
Help menu 

Injection 

Pack and Hold 
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Controller parameters for the pressure controller, pressure rates and velocity ramp 
during back pressure. 

Pressure P This parameter changes the proportional component of the 
pressure controller. It causes a proportional change in the 
output component. See also "Controller structure". 

Pressure I This parameter changes the integral component of the pres-
sure controller. It causes a velocity change in the output signal 
proportional to the time integral of the input signal. See also 
"Controller structure". 

Pressure D This parameter changes the derivative component of the pres-
sure controller. It causes a differentiated response of the out-
put signal corresponding to the rate of change of the input 
signal. See also "Controller structure". 

 

Pressure rate This parameter defines the Ramp time for an increase in pres-
sure command. See also "Creating command values with 
ramps". 

Decomp. rate This parameter defines the ramp time for a decrease in pres-
sure command. See also "Creating command values with 
ramps". 

 

Velocity ramp This parameter defines the Ramp rate for the open loop 
maximum valve output at the start of back pressure control. 
See also "Creating command values with ramps". 

 

 

Back Pressure 
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Adjust controller parameter for velocity and pressure for analog mode 

All the necessary control loop settings can be made with the control parameters. The 
values entered affect the loop behavior. 

 

Access to this screen is allowed at security level 1 only. 

 

 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Loop Tuning" window. A list of existing shortcuts for 
the toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 46 "Loop Tuning analog" window for analog mode 

The File menu in the "Parameters" window corresponds to the BODAC main window 
"File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

Loop Tuning analog 

Loop Tuning analog –  
File menu 

Loop Tuning analog –  
Controller menu 

Loop Tuning analog –  
Help menu 



Company Registered in England No: 4167649    VAT Registration No: 732 5692 25    BS EN ISO 9001:2008 No: LRQ 0964389

+44 (0)1204 699959
enquiries@hyquip.co.uk

Hyquip Limited   New Brunswick Street   Horwich   Bolton   Lancashire   BL6 7JB   UK

www.hyquip.co.uk/web/index

RE 30146-01-B/11.06  |  VT-HACD-DPQ Hydraulics  |  Bosch Rexroth AG 85/108 

Application: Controller for injection molding machines 5 

 

Controller parameters for the velocity controller during injection. 

Velocity P This parameter changes the proportional component of the 
velocity controller. It causes a proportional change in the out-
put component. See also "Controller structure". 

Velocity D This parameter changes the derivative component of the ve-
locity controller. It causes a differentiated response of the 
output signal corresponding to the rate of change of the input 
signal. See also "Controller structure". 

Vel. Active Damp-
ing 

This parameter changes the gain of the active damping path. 
See also "Controller structure". 

 

Controller parameters for the pressure controller during injection. 

Pressure P This parameter changes the proportional component of the 
pressure controller. It causes a proportional change in the 
output component. See also "Controller structure". 

Pressure I This parameter changes the integral component of the pres-
sure controller. It causes a velocity change in the output signal 
proportional to the time integral of the input signal. See also 
"Controller structure". 

Pressure D This parameter changes the derivative component of the pres-
sure controller. It causes a differentiated response of the out-
put signal corresponding to the rate of change of the input 
signal. See also "Controller structure". 

 

Controller parameters for the pressure controller during pack and hold and back pres-
sure. 

Pressure P This parameter changes the proportional component of the 
pressure controller. It causes a proportional change in the 
output component. See also "Controller structure". 

Pressure I This parameter changes the integral component of the pres-
sure controller. It causes a velocity change in the output signal 
proportional to the time integral of the input signal. See also 
"Controller structure". 

Pressure D This parameter changes the derivative component of the pres-
sure controller. It causes a differentiated response of the out-
put signal corresponding to the rate of change of the input 
signal. See also "Controller structure". 

 

Active damping for pressure loop 

Frequency This parameter changes the frequency of the filter of the active 
damping path. See also "Controller structure". 

Gain This parameter changes the gain of the active damping path. 
See also "Controller structure". 

 

Injection 

Pack and hold 
and back pressure 
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This parameter is used for protection of the Injection Axis in case of a failure in the 
analog command value. 

Target position This parameter defines the position at which the axis will stop 
regardless of the velocity command value. 

 

 

To de-activate this function enter a negative value. 

 

 

2 Valve / Bus option 

This window offers additional options for configuring this controller. 

 

Access to this screen is allowed at security level 2 only. 

 

Dead end protection 
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Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "2valve / Bus option" window. A list of existing shortcuts 
for the toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 47 "2 Valve / Bus option" window 

The File menu in the "Q-spool Config" window corresponds to the BODAC main win-
dow "File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

Inject The pressure override option allows the pressure loop to 
override the flow control during the inject profile. 
In a system that uses one injection proportional valve for 
both velocity and pressure control the pressure override 
must be turned on. 
In a system that uses separate valves for velocity and 
pressure control the pressure override must be turned off. 

Back Press. Step 1 see Inject 

Back Press. Step 2 see Inject 

Back Press. Step 3 see Inject 

Analog Inject see Inject 

Analog Hold see Inject 

Analog Back Pres. see Inject 

2valve / Bus option 

2valve / Bus option –  
File menu 

2valve / Bus option –  
Controller menu 

2valve / Bus option –  
Help menu 

Press Override 
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Inject Pressure loop feed forward multiplication factor. This pa-
rameter is necessary when the DPQ is controlling the 
pressure profile and a pressure control type proportional 
valve is connected to valve output 2. The pressure com-
mand set point for closed loop pressure control is multi-
plied by this value and added to the pressure control loop 
output. 
If the DPQ is controlling pressure using a pressure type 
proportional control valve connected to valve output 2 then 
this parameter should be set to 1.00. The percentage of 
the proportional valve command at output 2 will be equal to 
the pressure command. The closed loop pressure control-
ler will add or substract to that value as required to main-
tain the pressure set point. 
If the DPQ is controlling pressure using a single directional 
type proportional flow control valve connected to output 1 
then this parameter must be set to 0.00. The feed forward 
function is disabled with a value of 0.00. 

Back Press. Step 1 see Inject 

Back Press. Step 2 see Inject 

Back Press. Step 3 see Inject 
 

Pre Decompress Open loop pressure command in percent of  valve output 
2. This command is only used to drive a proportional pres-
sure control type valve that is connected to Valve Output 2 
during screw decompress. If there is no proportional pres-
sure control valve in the hydraulic system then these pa-
rameters have no influence. 

Post Decompress see Pre Decompress 
 

Inject Limit - Negative limits to valve output 2, in percent of full scale. 
This parameter is used to limit the direction of the valve 
output to a positive polarity when the DPQ is controlling the 
pressure. The limit is applied anytime a corresponding 
segment is selected. 
The negative limits should be set to 0.0% when a pressure 
type proportional valve is connected to output 2. If the PLC 
is controlling output 2 directly and a bi-directional type 
output is required then the negative limits should be set to -
100.0%. Also if output 2 is used as an analog output for 
position or pressure indication the negative limits should be 
–100.0%.  

Jog Limit - see Inject Limit -  

Back Press. Limit - see Inject Limit - 

Decomp Limit - see Inject Limit - 
 

Pressure Feed Fwd 

Decomp. Pressure 

Output 2 Setup 
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Screw Motor Control With this option it is possible to use output 1 to control 
hydraulic screw motor speed during back pressure control 
if the hydraulic circuit is configured to allow this function. 
Hidden: The screw motor is not controlled by the DPQ 
card. 
Visible: The screw motor is controlled by the DPQ via out-
put 1 during back pressure control. The flow settings will be 
visible on the Back Pressure screen. 

 

Out 2 Select type of output : 
- PLC controlled: the PLC will send commands via a bus 
and OUT2 acts as an analog PLC ouput 
– Pressure Profile: OUT 2 is used for a second valve for 
pressure control in a different hydraulic setup 
– Position Feedback: the position feedback is available at 
the connector side of the card 
– Pressure Feedback: the pressure feedback is available 
at the connector side of the card. 
- Velocity Feedback: the velocity feedback signal is avail-
able at the connector side of the card 

Out 3 Select type of output : 
- PLC controlled: the PLC will send commands via a bus 
and OUT3 acts as an analog PLC ouput 
- Position Feedback: the position feedback is available at 
the connector side of the card 
- Pressure Feedback: the pressure feedback is available at 
the rear connector side of the card 
- Velocity Feedback: the velocity feedback signal is avail-
able at the connector side of the card 

 

 

Calculation of the conversion factor from units to % is done by the 
following mathematical relationship: 

(Max Engineering Units / 100) * Conversion factor = 100%.  

Example for position: 

Max Engineering Units: 2000 mm 
Conversion factor = (100% *100) / 2000 mm = 5 [%/mm] 
 

 So if you are at an actual position of 500 mm the output will be:  
500 / 100 * 5 = 25 % = 2,5 V. 

Example for pressure:  

max 315 bar pressure transducer 
10000 / 315 = 31,75 
The value in this example is 31,75. So if you have an actual pressure 
of 120 bar  so the output will be: 

120 / 100 * 31,75 = 38,1% = 3,81 V. 

 

 

 

Options 

Output Source 
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Configure velocity for jog mode 

With the jog mode you can move the injector in open loop control.  

 Access to this screen is allowed at security level 1 only. 

 

 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Jog Mode" window. A list of existing shortcuts for the 
toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 48 "Jog Mode" window 

The File menu in the "Jog Mode" window corresponds to the BODAC main window 
"File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

This parameter defines the valve opening in Open Loop in the Inject forward direction. 
The position feedback should move towards „0“ in the inject forward direction. 

Jog Mode 

Jog Mode –  
File menu 

Jog Mode –  
Controller menu 

Jog Mode –  
Help menu 

Velocity (Jog +) 
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This parameter defines the valve opening in Open Loop in the Inject retract direction. 
The position feedback should move towards „100%“ in the inject retract direction. 

 

 

When using a Q-type spool retract motion (JOG-) requires a large 
value. 

 

 

Controller structure 

The complete controller structure of the HACD-DPQ is shown in Fig. 49. It consists of 
a position controller and a pressure controller followed by a minimum value generator. 
The minimum value generator defines what controller is active and ensures a bum-
pless transfer between the two. 

Velocity control is achieved by a position controller. The velocity command is the ramp 
rate for an internal position command. Position command and position feedback are 
used by the position controller which is configured as a P control.Damping of the ac-
tual position can be achieved by using the available Derivative (DT1) in the actual 
position branch. 

The Pressure controller is a PI controller. Damping of the actual pressure with a De-
rivative action in the feedback line can be configured. 

Active Damping is available as an enhancement for extremely demanding installa-
tions. Active Damping uses the actual pressure which is fed into a Highpass filter(D) 
multiplied by a factor (Gain) and can be added to either controller output. 
Active Damping can be used to stabilize the position control loop during the velocity 
profile. Active damping can be used to enhance the derivative action in the pressure 
control loop. 

Also referred to as pressure override function. The minimum value generator ensures 
that the transfer between multiple controller loops is bumpless. 

Velocity (Jog -) 

Velocity controller 

Pressure controller 

Active damping 

Minimum value generator 
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Active damping
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Fig. 49 Controller structure 
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5.5 Define profiles for internal or bus mode 

Configure profiles for injection 

Enter parameters for the injection velocity profile.  The injection cylinder moves the 
screw according to the steps that define the velocity profile (see "0" position in Fig. 50 
"Injection" window). 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Injection" window. A listing of existing shortcuts for the 
toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 50 "Injection" window 

The File menu in the "Injection" window corresponds to the BODAC main window "File 
menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

Fig. 51 shows the velocity change of the injection phase as a function position. 

See also: "Sequence diagram and function description", Injection. 

Injection 

Injection –  
File menu 

Injection –  
Controller menu 

Injection –  
Help menu 
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Fig. 51 Sequence diagram "Injection" 

Segment start positions. The next corresponding Injection segment (step) begins 
when the internal position command is equal to or less than the value in that step. 

 

 

Not all ten positions for the profile are necessary: The start position of 
any unused steps are set to zero. 

 

Segment travel velocity. The internal position command will ramp towards the next 
segments’ (step) start position at a rate determined by this value. 

 

 

The Injection velocity should be limited to slightly lower than the  
maximum speed that the hydraulic system is capable of producing. If a 
velocity set point much higher than the capability of the machine is 
used, then the DPQ will not be able to accurately control the injection 
profile. 

 

Maximum segment pressure limit. This command is used to either drive a proportional 
pressure control type valve which is connected to valve output 2, or to limit pressure 
with the proportional directional valve which is connected to valve output 1. The pres-
sure limit should be set high enough so it does not interfere with the velocity control in 
the segment. 

Position 

Velocity 

P max limiting 
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Acceleration rate at the start of the velocity profile. This parameter defines the time to 
accelerate to the velocity setpoint in the first segment. 

See also: section "Command value forming with ramps and S-ramps". 

Configure profiles for pack and hold 

Enter parameters for the Pack and Hold pressure profile. In the pack and hold phase 
the closed loop position controller is turned off and the hold pressure profile is turned 
on. 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Pack and hold" window. A list of existing shortcuts for 
the toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 52 "Pack and hold" window 

The File menu in the "Pack and Hold" window corresponds to the BODAC main win-
dow "File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

Acceleration Ramp 

Pack and hold 

Pack and hold –  
File menu 

Pack and hold –  
Controller menu 

Pack and hold –  
Help menu 
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Fig. 53 shows the pressure change during the pack and hold phase as a function of 
time t. 

See also: "Sequence diagram and function description", Pack and Hold. 

 
Fig. 53 Sequence diagram "Pack and Hold" 

 

NOTE!  

 
The internal command values in the profiles are absolute values. Check 
your entries after you have made them. 

 

Select the start condition for the pack and hold phase. 

 at a certain position 

 at a certain pressure (hydraulic or cavity) 

 using a rising edge on input DI-3 
 

 Position: Enter the desired cylinder position to begin Pack and Hold 

 Cavity Press: Enter a maximum value for the pressure (corresponds to max. units 
for the pressure transducer) 

 Hydr. Press: Enter a maximum value for the pressure (corresponds to max. units 
for the pressure transducer. 

 Position: Enter “0” value 

 DI-3: OFF 

Transfer by 

Transfer by position 
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 When the position setpoint is reached there is a transfer from the velocity profile 
to the Pack and Hold pressure profile. 

 

 Position: Enter “0” value 

 Cavity Press: Enter a maximum value for the pressure (corresponds to max. units 
for the pressure transducer). 

 Hydr. Press: Enter the desired hydraulic pressure to begin the pack and hold 
profile 

 Position: Enter a position at which a change-over to the pack and hold profile is 
permitted. A higher actual pressure before this point will not force a transfer. 

 DI-3: OFF 

 When the hydraulic pressure setpoint is reached there is a transfer from the ve-
locity profile to the Pack and Hold pressure profile. 

 
 Position: Enter “0” value 

 Cavity Press: Enter the desired mold cavity pressure to begin the pack and hold 
profile. 

 Hydr. Press: Enter a maximum value for the pressure (corresponds to max. units 
for the pressure transducer). 

 Position: Enter “0” value 

 DI-3: OFF 

 When the mold cavity pressure setpoint is reached there is a transfer from the 
velocity profile to the Pack and Hold pressure profile. 

 
 Position: Enter “0” value 

 Cavity Press: Enter a maximum value for the pressure (corresponds to max. units 
for the pressure transducer). 

 Hydr. Press: Enter a maximum value for the pressure (corresponds to max. units 
for the pressure transducer). 

 Position: Enter “0” value 

 DI-3: ON 

 When DI3 is turned ON (rising edge) there is a transfer from the velocity profile to 
the Pack and Hold pressure profile. 

 

 

All transfer conditions are active. Muliple conditions to start the pack 
and hold profile may be used, such as position and pressure. 

 

Enter values for the time (internal command values). The Pack and Hold Step 1 timer 
begins when one of the transfer functions has been satisfied. The next timer begins at 
the end of the preceding timer. 

 

 

If not all five steps of the profile are needed: 
“0” is entered in the time for any unused steps. 

 

Transfer by hydraulic pressure 

Transfer by mold cavity 
pressure 

Transfer by DI-3 

Time 
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Enter values for the pressure setpoint for each step of the pack and hold profile. The 
value of the Pack and Hold pressure is maintained in each step until the correspond-
ing time has expired. 

Enter values for the velocity limit for each step of the pack and hold profile. It is an 
open loop flow command to the valve output 1. These parameters may be used to 
limit the maximum opening of the flow control valve during Pack and Hold pressure 
changes. It is possible to set a value that is too low to build the pressure that is re-
quired for the corresponding pack and hold step.  

 Enter the corresponding values in the entry fields. 

 This concludes configuration of the pack and hold phase. 

 

 

Pressure 

Velocity 

Define structure of the pack and 
hold phase 
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Configure profiles for back pressure including pre- and post-decompression 

Enter parameters for back pressure control and screw decompression. As the screw 
turns, melted plastic material is augered to the front of the screw tip until a sufficient 
volume for injection is accumulated. Residual pressure in the melted plastic may be 
relieved using either pre- or post-decompression. 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Back pressure" window. A list of existing shortcuts for 
the toolbar can be found in Section 2.1 "Toolbar". 

 

 
Fig. 54 "Back Pressure" window 

The File menu in the "Back pressure" window corresponds to the BODAC main win-
dow "File menu". 

Contains commands for reading, writing and modifying parameters. 
 

Takes you directly to the help for the current topic or to the contents page of the BO-
DAC windows help. 

 

Back pressure 

Back Pressure –  
File menu 

Back Pressure –  
Controller menu 

Back Pressure –  
Help menu 
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Pre-Decompression 

The Pre Decompress function is automatically enabled at the end of the Pack and 
Hold profile. It does not need an extra discrete input which saves cycle time. 

Fig. 55 shows the position change during the pre-decompression phase. 

See also: "Sequence diagram and function description", Pre-Decompression. 

 
Fig. 55 Sequence diagram "Pre-decompression phase" 

 

NOTE!  

 
The internal command values in the profiles are absolute values. Check 
your entries after you have made them. 

 

Enter values for the pre-decompress stop position.  
If Pre Decompression is not required then enter a value less than the minimum cush-
ion position into this parameter (Typically “0”). Discrete Output DO5 is set when the 
value of the injection cylinder position feedback is equal to or greater than the value in 
the Pre Decompression Position parameter. 

Enter values for the pre-decompress velocity. It is an open loop flow command to 
valve output 1. When Pre Decompression is completed (DO5 “ON”), valve output 1 is 
set to zero. 

 Enter the corresponding values in the entry fields. 

 This concludes configuration of the pre-decompression phase. 

Position 

Velocity 

Define structure of the pre-
decompression phase 
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If the phase Pre-Decompression is not used enter a Position "0". 

 

Back Pressure 

The Back Pressure profile may use up to 3 pressure control steps. This mode is trig-
gered when the screw is turning. 

Fig. 56 shows the pressure change of the back pressure phase as a function of posi-
tion. 

See also: "Sequence diagram and function description", Back pressure. 

 

 
Fig. 56 "Back pressure" sequence diagram 

 

NOTE!  

 
The internal command values in the profiles are absolute values. Check 
your entries after you have made them. 

 

Enter values for step 2 and step 3 start position if used. 

 

 

If not all steps are needed for the profile: The start position for the 
unused steps should be set to maximum stroke length. 

 
 

Position 
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Enter values for the Shot Size Position. Discrete output DO6 “At Shot Size” is turned 
on whenever the value of the injection cylinder position feedback is equal to or greater 
than the value in the Shot Size parameter. Also discrete output DO3 “Back Pressure” 
is turned of, when Shot size Position is reached.  

Open loop flow command to the valve output 1. This parameter is used to control the 
valve opening to be used during the corresponding recovery segment.  
Normally this parameter is hidden and can be made visible in the Option screen with 
Screw Motor Control -> VISIBLE.  
It’s set per default to zero. This will allow the valve output 1 only to reach negativ limits 
during Back Pressure. This will block the P->A curve for Back Pressure. Depending of 
the spool setup these values might be changed by user. 
If the hydraulic system is installed that way, these parameters can be used to set the 
screw speed. 
Valve output 1 is set to zero when the Back Pressure trigger is lowered. 

Enter values for the Back Pressure profile steps. This command is used to either drive 
a proportional pressure control type valve which is connected to valve output 2, or 
used to limit pressure with the proportional directional valve which is connected to 
valve output 1. The value of the Back Pressure parameter is maintained in each Back 
Pressure step until the next segment is reached or the Back Pressure trigger is low-
ered. 

 Enter the corresponding values in the entry fields. 

 This concludes configuration of the back pressure phase. 

 

Post-Decompression 

Enter the parameters for Post-decompression, if used. Post-Decompression must be 
triggered. When triggered by DI6 (rising edge) the screw retracts to a defined stopping 
position. 

Fig. 57 shows the position change of the screw during retraction after the back pres-
sure phase. 

See also: "Sequence diagram and function description", Post-decompression 

Shot Size Position 

Screw Speed 

Pressure 

Define structure of the back 
pressure phase 
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Fig. 57 "Screw retraction after back pressure" sequence diagram 

 

NOTE!  

 
The internal command values in the profiles are absolute values (Rela-
tive positions are NOT supported). Check your entries after you have 
made them. 

 

Enter the value for Post -Decompress stop position. Post Decompression is complete 
when the value of the injection cylinder position feedback is equal to or greater than 
the value in the Post Decompression Position parameter. If Post Decompression is 
not required then do not raise the Post Decompression trigger. 
Post Decompression may be triggered to pull the injection cylinder back to the Post 
Decompression Position at any time by raising the Post Decompression trigger dis-
crete input DI6. 
Discrete Output DO5 is on when the Post Decompression function is triggered and the 
value of the injection cylinder position feedback is equal to or greater than the value in 
the Post Decompression Position parameter. 

Enter the value for the Post-Decompress velocity. It is an open loop flow command to 
valve output 1. When Post-Decompression is completed (DO5 “ON”), valve output 1 is 
set to zero. 

 Enter the corresponding values in the entry fields. 

 This concludes configuration of the post-decompression phase. 

Position 

Velocity 

Define structure of the post-
decompression phase 
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Creating command values with ramps 
 

 

Ramps are necessary for parameterizing velocity and pressure com-
mands. 

 
Stable control  requires a command profile that can be achieved by the hydraulic 
system. Step changes of command values must be avoided. Therefore, after a profile 
command value has been triggered, the current command is passed through ramps 
towards the profile command. The ramped value is sent to the loop controller as the 
loop command. 

The ramps are configured in seconds (s). 

Fig. 58 shows the ramp function using a number example. 

pressure resulting
ramp time

command value = 50 bar
(command value jump)

 
Fig. 58 Command value forming using the "Ramp" transfer function 

 Command value at 20 bar 

 Max. pressure = 200 bar 

 Ramp time = 20 s 

 New command value = 70 bar => command value difference = 50 bar 
 

 The ramp time of 20 s refers to the equation 100 % = 200. The command value 
change is 50 bar with a resulting ramp time of 5 s. 

 

Ramp 

Pre-defined settings 

Result 

Velocity 
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gradient via
velocity command

 
Fig. 59 Velocity 

 Travel difference: s = 80 mm 

 Velocity: v = 250 mm/s 
 

 Travels 

t = s/v follows 

t = (80 mm) / (250 mm/s) 

time t = 0.32 s 

 

See also: section "Injection phase". 

 

 

5.6 Save parameter file 

 All necessary functions have been parameterized. 

 Save the data record in a parameter file (FILENAME.PARAM). The parameter file 
is stored in the predetermined directory \user\. 

 

 

See section "Save". 

 

 

Pre-defined settings 

Result 
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5.7 Process settings 

This will give the user a quick overview of: 

 the current parameters 

 the current data structure 

 the signals which are present 

 the status of the card 

 

Motion data 

The entire signal sequence of your application can be monitored in real-time. 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Motion data" window. A list of existing shortcuts for the 
toolbar can be found in Section 2.1 "Toolbar". 

See section "Motion data". 

 

 

Test jacks 

For diagnostic purposes signals can be assigned to the "X2" test jack on the front 
panel of the card. 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Test jacks" window. A list of existing shortcuts for the 
toolbar can be found in Section 2.1 "Toolbar". 

See Section "Test jacks". 

 

Status overview 

The "Status overview" window provides an overview of the current faults which were 
detected while the HACD-DPQ was operating. 

 

Clicking on the preceding symbol, which is a component of the toolbar, 
also opens the "Status overview" window. A list of existing shortcuts 
for the toolbar can be found in Section 2.1 "Toolbar". 

See section "Status overview". 

 

 

Process display 

Test jacks 

Status overview 
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5.8 Start application 

The application is started after setting: 

 digital input "D18". This input is always linked with the ENABLE function of the 
controller card. 

and 

 digital input "DI 2” (AUTO) for internal closed loop profiles. 

and 

 Mode dependant DI x or Bus Trigger. 

 

See also chapter 2.4 “Sequence diagram and functional description”. 

 

 
 

 

Starting up 
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